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Chapter 4 

Resonant Circuits and Filters 
 

4.1 Introduction 

 

The first half of this chapter examines resonant circuits. The second half is 

an introduction to the vast subject of filter networks. In the first half we 

discuss the lumped and distributed element resonant circuits and the 

equivalent networks of mechanical resonators. Resonant circuits are used 

in many applications such as filters, oscillators, tuners, tuned amplifiers, 

and microwave communication networks. The analysis of basic series and 

parallel RLC resonant circuits is implemented using the Keysight ADS 

software. The discussion turns to microwave resonators with an analysis 

of the Q factor and transmission line resonators. In the second half of the 

chapter the design of lumped element filters is followed by an introduction 

to distributed element filters. The chapter concludes with the design of 

microstrip stepped impedance and microstrip coupled line filters. In the 

analysis and design of all resonant and filter networks the use of Keysight 

ADS software is demonstrated.  

 

4.2 Resonant Circuits 

 

Near resonance, RF and microwave resonant circuits can be represented 

either as a lumped element series or parallel RLC networks. 

 

4.2.1 Series Resonant Circuits 
In this section we analyze the behavior of the series resonant circuits in 

ADS. 

 

Example 4.2-1: Consider the one port series resonator that is represented 

as a series RLC circuit of Figure 4-1. Analyze the circuit, with R = 10 , 

L = 10 nH, and C = 10 pF.  

 

Solution: The procedure for ADS analysis is as follows. This procedure 

will be repeated throughout the book. 
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 Start ADS and create a new workspace 

 Name the workspace Ex4.2-1_wrk 

 From the Main window create a new schematic in cell_1 

 In the schematic window, click Insert > Template >ads-

templates:S_Params 

 Delete the DisplayTemplate icon 

 Place R, L, and C elements from the Lumped-Components palette   on 

the schematic and connect them as shown in Figure 4-1. 

 Set R=10 Ω, L=10 nH, and C=10 pF 

 Type in Zin in the part selection box and place it on the schematic to 

measure the input impedance of the circuit.  

 Set the frequency range from 450 to 550 MHz in 1 kHz step and wire 

up the schematic as shown in Figure 4-1 

 

 
 

Figure 4-1 One-port series RLC resonator circuit  

 

The plot of the resonator’s input impedance in Figure 4-2 shows that the 

resonance frequency is about 503.3 MHz and the input impedance at 

resonance is 10 the value of the resistor in the network. 



6 RF and Microwave Circuit Design 

 

 

 

 
 

Figure 4-2 Input impedance showing the resonance frequency at m1  

 

The input impedance of the series RLC resonant circuit is given by, 

 

C
jLjRZ in



1

  

 

where,  = 2πf is the angular frequency in radian per second. 

 

If the AC current flowing in the series resonant circuit is I, then the complex 

power delivered to the resonator is  

 






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  (4-1) 

 

At resonance the reactive power of the inductor is equal to the reactive power 

of the capacitor. Therefore, the power delivered to the resonator is equal to the 

power dissipated in the resistor 

 

2

2
RI

Pin      (4-2) 
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4.2.2 Parallel Resonant Circuits 

 

Example 4.2-2: Analyze a rearrangement of the RLC components of Figure 

4-1 into the parallel configuration of Figure 4-3. The schematic of Figure 4-3 

represents the lumped element representation of the parallel resonant circuit.  

 

Solution: The one port parallel resonant circuit is shown in Figure 4-3.  

 

 
 

Figure 4-3 One-port parallel RLC resonant circuit  

 

Simulate the schematic and display the input impedance in a rectangular plot. 

The plot of the magnitude of the input impedance shows that the resonance 

frequency is still 503.3 MHz where the input impedance is R = 10 . Again 

this shows that the impedance of the inductor cancels the impedance of the 

capacitor at resonance. In other words, the reactance, XL, is equal to the 

reactance, XC, at the resonance frequency. 
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Figure 4-4 Input impedance of parallel RLC resonant circuit  
 

The input admittance of the parallel resonant circuit is given by: 

 

L
jCj

R
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

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       

 

If the AC voltage across the parallel resonant circuit is V, then the complex 

power delivered to the resonator is  
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  (4-3) 

 

At resonance the reactive power of the inductor is equal to the reactive power 

of the capacitor. Therefore, the power delivered to the resonator is equal to the 

power dissipated in the resistor 

 

R

V
Pin

2

2

      (4-4) 

 

The resonance frequency for the parallel resonant circuit as well as the series 

resonant circuit is obtained from: 
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CL
foo

1
2       (4-5) 

 

where, 0 is the angular frequency in radian per second and f0 is equal to the 

frequency in Hertz.  

 

4.2.3 Resonant Circuit Loss 

 

In Figures 4-1 and 4-3 the resistor R1 represents the loss in the resonator. It 

includes the losses in the capacitor as well as the inductor. The Q factor can be 

shown to be a ratio of the energy stored in the inductor and capacitor to the 

power dissipated in the resistor as a function of frequency [6]. For the series 

resonant circuit of Figure 4-1 the unloaded Q factor is defined by: 

 

RCR

L

R

X
Q

o

o
u



 1
     (4-6) 

 

The unloaded Q factor of the parallel resonant circuit in Figure 4-3 is simply 

the inverse of the unloaded Q factor of the series resonant circuit. 

 

RC
L

R

X

R
Q o

o
u 


     (4-7) 

 

We can clearly see that as the resistance increases in the series resonant 

circuit, the Q factor decreases. Conversely as the resistance increases in the 

parallel resonant circuit, the Q factor increases.  

 

The Q factor is a measure of loss in the resonant circuit. Thus a higher Q 

corresponds to lower loss and a lower Q corresponds to a higher loss. It is 

usually desirable to achieve high Q factors in a resonator as it will lead to 

lower losses in filter applications or lower phase noise in oscillators. Note that 

the resonator Q of Equation (4-6) and (4-7) is defined as Qu, the unloaded Q 

of the resonator. This means that the resonator is not connected to any load. 
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Equations (4-6) and (4-7) would then have to be modified to include the 

source and load resistance. We might also surmise that any reactance 

associated with the source or load impedance may alter the resonant frequency 

of the resonator. This leads to two additional definitions of Q factor that the 

engineer must consider: the loaded Q and the external Q. 

 

4.2.4 Loaded Q and External Q  
 

Analyze the parallel resonator that is attached to a 50  source and load as 

shown in Figure 4-5.  

 

 
 

Figure 4-5 Parallel resonator with source and load impedance  

 

Using Equation (4-7) to define the Q factor for the circuit requires that we 

include the source and load resistance which is ‘loading’ the resonator. This 

leads to the definition of the loaded Q, or QL, for the parallel resonator as 

defined by Equation (4-8). 

 

L

RRR
Q

o

LS

L



     (4-8) 

 

Conversely we can define a Q factor in terms of only the external source and 

load resistance. This leads to the definition of the external Q, or QE. 
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L

RR
Q

o

LS

E



     (4-9) 

 

The three Q factors are related by the inverse relationship of Equation (4-10). 

 

UEL QQQ

111
     (4-10) 

 

At RF and microwave frequencies it is difficult to directly measure the Qu of a 

resonator. We may be able to calculate the Q factor based on the physical 

properties of the individual inductors and capacitors as we have seen in 

chapter 1. This is usually quite difficult and the Q factor is typically measured 

using a Vector Network Analyzer, VNA. Therefore, the measured Q factor is 

usually the loaded Q, or QL. External Q is often used with oscillator circuits 

that are generating a signal. In this case the oscillator’s load impedance is 

varied so that the external Q can be measured. The loaded Q of the network is 

then related to the fractional bandwidth by Equation (4-11) [8]. 

 

dB

hl

L
BW

ff
Q

3

     (4-11) 

 

where, BW is the -3 dB bandwidth, 
l

f  and
h

f  are the lower and upper 

frequencies in Hz at -3dB points.  

 

4.3 Lumped Element Parallel Resonator Design 

 

Example 4.3-1: In this example we design a lumped element parallel 

resonator at a frequency of 100 MHz. The resonator is intended to operate 

between a source resistance of 100  and a load resistance of 400 .  

 

Solution: Best accuracy would be obtained by using S-parameter files or 

Modelithics models for the inductor and capacitor. However a good first order 

model can be obtained by using the ADS inductor and capacitor models that 

include the component Q factor. These models save us the work of calculating  

 

 



12 RF and Microwave Circuit Design 

 

 

 

the equivalent resistive part of the inductor and capacitor model. The 

component Q factors are shown in the schematic of Figure 4-6. 

 

 
 

Figure 4-6 Parallel resonator using components with assigned Q factors 

 

Simulate the schematic and display the insertion loss in a rectangular plot. 

 

 
 

Figure 4-7 Insertion loss and calculation of 3 dB bandwidth and Q factor 

 

Note that markers have been placed on the plot of the insertion loss, S21, that 

gives readout of -3 dB bandwidth. To place markers m2 and m3 manually at -

3dB points, first place marker m1 at the peak of S21 trace. Next place marker 

m2 at a point below marker m1. Select marker m2 and press the up and down 

arrows to move the marker m2 as close to -3dB point as possible. Repeat the  
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process for marker m3. The loaded Q can be calculated using Equation (4-11). 

 

94.16
901.5

98.99


MHz

MHz

BW

ff
Q hl

L
 

 

The designer must use caution when sweeping resonant circuits. Particularly 

high Q band pass networks require a large number of discrete frequency steps 

in order to achieve the necessary resolution required to accurately measure the 

3dB bandwidth. The ADS measurement function bandwidth_func(db(S21),3) 

also measures the 3 dB bandwidth very accurately. 

 

4.3.1 Effect of Load Resistance on Bandwidth and QL 

 

In RF circuits and systems the impedances encountered are often quite low, 

ranging from 1  to 50 . It may not be practical to have a source impedance 

of 100  and a load impedance of 400 . In the next section we replace these 

impedances with 50 Ohm resistors.   

 

Example 4.3-2: In the parallel LC Example 4.3-1, change the load from 400 

to 50  and re-examine the circuit’s 3 dB bandwidth and QL.  

 

Solution: Change the load resistance from 400 to 50  as shown in Figure 

4-8.  

 

 
 

Figure 4-8 Parallel resonance circuit  
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Simulate the schematic and display the insertion loss in a rectangular plot. In 

ADS the bandwidth_func() function uses an iterative process to interpolate 

between simulated points.  

 

 
 

Figure 4-9 Insertion loss of parallel resonance circuit  

 

Notice the 3 dB bandwidth is now 12.88 MHz resulting in a loaded Q factor of 

7.76.  

76.7
88.12

958.99


MHz

MHz

BW

ff
Q hl

L
 

 

The loaded Q factor has decreased by nearly half of the original value. We 

have increased the bandwidth or de-Q’d the resonator. This can also be 

thought of as tighter coupling of the resonator to the load. 

 

4.4 Lumped Element Resonator Decoupling  
 

To maintain the high Q of the resonator when attached to a load such as 50 , 

it is necessary to transform the low impedance to high impedance presented to 

the load. The 50  impedance can be transformed to the higher impedance of 

the parallel resonator thereby resulting in less loading of the resonator 

impedance. This is referred to as loosely coupling the resonator to the load. 

The tapped-capacitor and tapped-inductor networks can be used to accomplish 
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this Q transformation in lumped element circuits. 

 

4.4.1 Design of the Tapped Capacitor Resonator  

 

Example 4.4-1: Consider rearranging the parallel LC network of Figure 4-8 

with the tapped capacitor network shown in Figure 4-10. Re-examine the 

circuit’s 3 dB bandwidth and QL.  

 

Solution: The new capacitor values for C1 and C2 can be found by the 

simultaneous solution of the following equations [2]. 

 

21

21

CC

CC
CT




     (4-12) 

 
2

1
2

1
1 










C

C
RR LL     (4-13) 

 

RL1 is the higher, transformed, load resistance. In this example substitute RL1 = 

400 , the original load resistance value. CT is simply the original capacitance 

of 398 pf. The capacitor values are found to be: C1 = 1126.23 pF and C2 = 

616.1 pF. The new resonator circuit is shown in Figure 4-10. 

  

 
 

Figure 4-10 Parallel LC resonator using tapped capacitor  

 

Sweeping the circuit we see that the response has returned to the original 

performance of Figure 4-7. 
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Figure 4-11 Response of parallel LC resonator using a tapped capacitor  

 

The 3 dB bandwidth has returned to 5.89 MHz making the QL equal to:  

 

94.16
897.5

92.99


MHz

MHz

BW

ff
Q hl

L
 

 

The 50  load resistor has been successfully decoupled from the resonator.  

The tapped capacitor and inductor resonators are popular methods of 

decoupling RF and lower microwave frequency resonators. It is frequently 

seen in RF oscillator topologies such as the Colpitts oscillator in the VHF 

frequency range. 

 

4.4.2 Design of the Tapped Inductor Resonator  

 

Example 4.4-2: Similarly design a tapped inductor network to decouple the 

50 source impedance from loading the resonator.  

 

Solution: Replace the 100  source impedance with a 50  source and use a  
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tapped inductor network to transform the new 50  source to 100 . Modify 

the circuit to split the 6.37 nH inductor, LT, into two series inductors, L1 and   

 

L2. The inductor values can then be calculated by solving the following 

equation set simultaneously [2]. RS1 is the higher, transformed, source 

resistance. In this example substitute RS1 = 100 , 

 

2

1

1 









L

L
RsRs T

   (4-14) 

21 LLLT      (4-15) 

 

Solving the equation set results in values of L1=4.5 nH and L2=1.87 nH. The 

resulting schematic and response are shown in Figures 4-12 and 4-13.  

 

 
 

Figure 4-12 Tapped-inductor parallel resonant circuit 

 

The new response is identical to the plot of Figure 4-7. Therefore we now 

have a source and load resistance of 50  and have not reduced the Q of the 

resonator from what we had with the original source resistance of 100  and a 

load resistance of 400 . 
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Figure 4-13 Response of the parallel resonant circuit 

 

4.5 Practical Microwave Resonators 
 

At higher RF and microwave frequencies resonators are seldom realized with 

discrete lumped element RLC components. This is primarily due to the fact 

that the small values of inductance and capacitance are physically 

unrealizable. Even if the values could be physically realized we would see that 

the resulting Q factors would be unacceptably low for most applications. 

Microwave resonators are realized in a wide variety of physical forms. 

Resonators can be realized in all of the basic transmission line forms that were 

covered in Chapter 2. There are many specialized resonators such as ceramic 

dielectric resonator pucks that are coupled to a microstrip transmission line as 

well as Yittrium Iron Garnet spheres that are loop coupled to its load. These 

resonators are optimized for very high Q factors and may be tunable over a 

range of frequencies. 
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Figure 4-14 Ceramic dielectric resonator (puck) and coaxial resonator 

 

4.5.1 Transmission Line Resonators 
 

From Figure 2-20 we have seen that a quarter-wave short-circuited 

transmission line results in a parallel resonant circuit. Similarly Figure 2-22 

showed that a half-wave open circuited transmission line results in a parallel 

resonant circuit. Such parallel resonant circuits are often used as one port 

resonators. Near the resonant frequency, the one port resonator behaves as a 

parallel RLC network as shown in Figure 4-2. As the frequency moves further 

from resonance the equivalent network becomes more complex typically 

involving multiple parallel RLC networks. One port resonators are coupled to 

one another to form filter networks or directly to a transistor to form a 

microwave oscillator. Knowing the losses due to the physical and electrical 

parameters of the transmission line, one can calculate the Qu of the 

transmission line resonator. The microstrip resonator Qu is comprised of 

losses due to the conductor metal, the substrate dielectric, and radiation losses. 

The Qu is often dominated by the conductor Q. Unfortunately it can be quite 

difficult to accurately determine the conductor losses in a microstrip 

resonator. T. C. Edwards has developed a set of simplified expressions for the 

conductor losses [4]. Equation (4-16) is an approximation of the conductor 

losses that treats the transmission line as a perfectly smooth surface. 

 

g

oe

c
ZW

f
 072.0   dB/inch (4-16) 

 

Where: 
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f = the frequency in GHz 

 We = the effective conductor width (inches) 

 Zo = the characteristic impedance of the line 

c= Conductor loss in dB/inch 

g = wavelength in dielectric in inches

 

A microstrip conductor is actually not perfectly smooth but exhibits a certain 

roughness. The surface roughness exists on the bottom of the microstrip 

conductor where it contacts the dielectric. This can be seen by magnifying the 

cross section of a microstrip line’s contact with the dielectric material. The 

surface roughness is usually specified as an r.m.s. value. 

 

 
 

Figure 4-15 Cross section of microstrip line showing surface roughness at 

the conductor to dielectric interface (courtesy of Tektronix) 

 

Edwards modified Equation (4-16) to include the effects of the surface 

roughness as given by Equation (4-17). 
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where,  is the r.m.s. surface roughness and  s is the conductor skin depth.

The corresponding Q factor related to the conductor is then given by: 

 

oc

eff

cQ


3.27
     (4-18) 

 

The dielectric loss is determined by the dielectric constant and loss tangent. It 

is calculated using Equation (4-19). 
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where: 

 

  r = the substrate dielectric constant 

 reff = the effective dielectric constant  

tan = the loss tangent of the dielectric 

o = wavelength in inches 

 

The corresponding Q factor due to the dielectric is then given by: 

 

od

eff

dQ



3.27     (4-20) 

 

We know that a microstrip line will also have some radiation of energy from 

the top side of the line. The open circuit stub will also experience some 

radiation effect from the open circuited end. On low dielectric constant 

substrates, r < 4.0, the radiation losses are more significant for high 

impedance lines. Conversely for high dielectric constant substrates, r > 10, 

low impedance lines experience more radiation loss [10]. The radiation Q factor 

is presented as Equation (4-21) [9]. 
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where, h = substrate thickness in cm. 

 

Note that in Equation (4-21) the line impedance and effective dielectric 

constant are defined as functions of frequency. This includes the dispersion or 

frequency dependent effect of Zo and eff. Dispersion tends to slightly increase  

the eff as the frequency increases. This dispersive Zo and eff are given in 

Equations (4-22) and (4-23). 
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where, 

 

h = substrate thickness in mils 

 t = conductor thickness in mils 
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)(
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Finally the resultant overall unloaded Q factor, Qu, of the microstrip line can 

be determined by the reciprocal relationship of Equation (4.24). 

 

rdcu QQQQ

1111
     (4-24) 

 

4.5.2 Microstrip Resonator Example 
 

Example 4.5-1: Design a 5 GHz half wavelength open circuit microstrip 

resonator. The resonator is realized with a 50  microstrip line on Roger’s 

RO3003 dielectric. Calculate the unloaded Q factor of the resonator. The 

substrate parameters are defined as: 

 

Dielectric constant  r = 3 

 Substrate height  h = 0.030 in. 

 Conductor thickness  t = .0026 in. 

 Line Impedance Zo = 50  

 Conductor width w = 0.077 in. 

 Loss tangent  tan = 0.0013 

 

Solution: Using the simplified expression of Equation (4-16) for a smooth 

microstrip line the conductor loss and Q factor is calculated as: 

 



Resonant Circuits and Filters 23 

 

inchdBc /063.0)52.1(
)50(077.0
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  
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41.23.27
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The dielectric loss and Q factor are then calculated from Equation (4-19) and 

(4-20). 
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For simplicity the radiation Q factor will be omitted. We will model the 

resonator using the ADS Linear simulator. Linear simulators often do not 

model the radiation effects of the microstrip line. Therefore the overall 

unloaded Q factors then becomes. 

 

9.213

1

2.875

1

1.283

11


u
Q

 

 

9.213uQ  

 

4.5.3 ADS Model of the Microstrip Resonator 

 

The half wave open-circuited microstrip resonator is modeled in ADS as 

shown in Fig 4-16. Note that the source and load impedance has been 

increased to 5000  to avoid loading the impedance of the parallel resonant  

circuit. Perform a linear sweep of the resonator using 0.1 MHz step from 4500 

MHz to 5400 MHz.  
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Figure 4-16 Half-wave open ended microstrip resonator 

 

Simulate the schematic and display the S21, the -3 dB bandwidth, and the 

loaded Q factor, as shown in Figure 4-17.  

 

 
 

Figure 4-17 Response of the half-wave open circuit microstrip resonator 

 

Using the techniques of section 4.2.3 and Equation (4-10), the 3dB bandwidth 

is measured to determine the loaded Q of the resonator. 

 

16.73
68

88.4974


MHz

MHz
QL
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The insertion loss at the resonant frequency can be used to relate the loaded Q 

factor to the Qu as shown by Equation (4-25).  

 

Lu

u

QQ

Q
dBossInsertionL


 log20)(    (4-25) 

 

Or:   
16.73

log2076.0



u

u

Q

Q
    

 

7.882uQ

  

4.6 Resonator Series Reactance Coupling  
 

To reduce the loading on the half wave resonator of Figure 4-16, the source 

and load impedances of 5000 were used. In practice the resonator is 

typically coupled to lower impedance circuits. If we attempt to examine the 

resonator on a network analyzer, most modern test equipment will have 50  

impedance levels. Such resonators are often coupled to the circuit by a highly 

reactive circuit element. This reactive element can be realized as a series 

capacitor or inductor. The resonator is then analyzed as a one port network. 

As the frequency is swept over a narrow frequency range around the resonant 

frequency, a circle is formed on the Smith chart. This trace is known as the Q 

circle of the resonator [5]. Figure 4-19 shows the Smith chart plot of the 

resonator’s input reflection coefficient, S11. Three plots are shown each with 

a different value of coupling capacitance. We can see that as the coupling 

capacitance changes, the resonant frequency of the circuit also changes. The 

series capacitance acts to decrease the overall resonance frequency of the 

circuit. This new resonance frequency is known as the loaded resonance 

frequency. Because the series capacitance lowers the frequency, the length of  

the resonator was decreased to 0.736 inches to return the resonant frequency  

close to 5 GHz. With the coupling capacitance set at 0.027 pF the Q circle 

passes through the center of the Smith chart at the resonant frequency. This is 

known as critical coupling and is characterized by having the lowest return 

loss on the scalar plot of Figure 4-20. With the capacitance increased to 0.05 

pF the resonator is more strongly coupled to the 50  load. The scalar plot 

shows that the resonance frequency is decreased. The Smith chart shows a 
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larger Q circle which is a characteristic of an over coupled resonator. With the 

coupling capacitor set to 0.015 pF the resonance frequency increases. The 

Smith chart shows that the Q circles become much smaller thus under 

coupling the resonator.  

 

As Figure 4-20 shows, the value of the coupling capacitor also has an impact 

on the size of the Q circle. The diameter of the Q circle is dependent on the 

coupling of the resonator to the 50  source. 

 

 
 

Figure 4-18 Capacitive coupled half-wave microstrip resonator  
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Figure 4-19 Smith chart plots of the resonator input reflection coefficients 

 

Figure 4-20 shows the scalar plot of the input reflection coefficients.  

 

 
 

Figure 4-20 Scalar plots of the resonator input reflection coefficients 
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4.6.1 One Port Microwave Resonator Analysis 

 

The microstrip half wave resonator was fairly easy to model and analyze in 

ADS. Many microwave resonators are not as easy to model. High Q 

microwave resonators are often realized as metallic cavities or dielectric 

resonators. The reactive coupling of the resonator to the circuit can be even 

more difficult to model. The coupling usually occurs by magnetic or electric 

coupling by a probe or loop inserted into the cavity. An E field probe coupled 

to a coaxial cavity resonator is shown in Figure 4-21. A dielectric resonator is 

coupled to a microstrip line by flux linkage in air as shown in Figure 4-22. 

The designer is left to develop approximate models based on a lumped RLC 

equivalent models and couple the resonator to the circuit using an ideal 

transformer model. Linear simulation can still be of value in the design and 

evaluation process if we have a measured S parameter file of the resonator’s 

reflection coefficient. Just as we have used S parameter models to represent 

capacitors and inductors we can also use the measured S parameters of a 

resonator. All modern vector network analyzers have the ability to save an S 

parameter data file for any measurement that can be made by the instrument. 

This section will show how we can use ADS to analyze the S parameter file of 

a microwave resonator. 

 

 
 

Figure 4-21 Coaxial cavity with E field probe coupled to center conductor 

 

The coupling of microwave resonators is often characterized by a coupling 

coefficient k. The coupling coefficient is the ratio of the power dissipated in 

the load to the power dissipated in the resonator [5].  
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k      (4-27) 

where:  

  

Qo is the unloaded Q of the resonator 

 

Qext is the external Q of the resonator 

 

When Pload is equal to Presonator , k = 1 and the critical coupling case exists. 

Substituting the reciprocal Q factor relationship of Equation (4-10) into 

Equation (4-27) we can relate the coupling coefficient to the loaded QL and 

unloaded Qo of the resonator. 
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    (4-28) 

 

 
 

Figure 4-22 Dielectric resonator coupled to microstrip transmission line 

 

Now the unloaded Qo of the resonator can be calculated if the QL and k can be 

measured. Because the resonator is a one port device we cannot pass a signal 

through the device and measure the 3dB bandwidth as was done in section 

4.5.3. Kajfez [5] has described a technique to extract the coupling coefficient k 

and QL values from the Q circle of the resonator. Consider the Q circle on the 

Smith chart of Figure 4-23. A line that is projected from the center of the 

Smith chart to intersect the Q circle with minimum length will intersect the 

circle at the loaded resonance frequency, fL. The length of this vector is  
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labeled as |L|. As the line projects along a path of the diameter of the circle it 

intersects the circle near the circumference of the Smith chart at a point 

defined as |d|. The input reflection coefficient of the Q circle can be defined 

using the following empirical equation [5]. 
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Lines that are projected from d through the Q circle at the angles +are 

related to the loaded Q by Equation (4-30). 
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If we set = 45o then Equation (4-30) reduces to the straightforward 

definition of QL given by Equation (4-31). 
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In section 2.6 we noticed that the diameter of the circle was directly related to 

the coupling coefficient. The circle diameter can be measured from: 

 

dLd      (4-32) 

 

The coupling coefficient is then derived from the diameter of the Q circle. 
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Finally the unloaded resonator Qo is then calculated from Equation (4-28). We 

can also find the unloaded resonance frequency directly from the Q circle. 
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Follow the reactive line on the Smith chart that intersects the Q circle at d to 

the next Q circle intersection. The frequency at this Q circle intersection is the 

unloaded resonance frequency, fo. 

 

 
 

Figure 4-23 Resonator Q measurement from the resonator Q circle 

 

4.7 Filter Design at RF and Microwave Frequency 

 

In Section 4.3 we have seen that it is possible to change the shape of the 

frequency response of a parallel resonant circuit by choosing different source 

and load impedance values. Likewise multiple resonators can be coupled to 

one another and to the source and load to achieve various frequency shaping 

responses. These networks are referred to as filters.  

 

4.7.1 Filter Topology 
 

The subject of filter design is a complex topic and the subject of many 

dedicated texts [1, 2]. This section is intended to serve as a fundamental primer 
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to this vast topic. It is also intended to set a foundation for successful filter 

design using the ADS software. The four most popular filter types are: Low  

Pass, High Pass, Band Pass, and Band Stop. The basic transmission response 

of the filter types is shown in Figure 4-24A and 4-24B. The filters allow RF 

energy to pass through their designed pass band. RF energy that is present 

outside of the pass band is reflected back toward the source and not 

transmitted to the load. The amount of energy present at the load is defined by 

the S21 response. The amount of energy reflected back to the source is 

characterized by the S11 response. 

 

 
 

Figure 4-24A S21 versus frequency characteristic for the basic filter types 

 

 
 

Figure 4-24B S21 versus frequency characteristic for the basic filter types 
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4.7.2 Filter Order 
 

The design process for all of the major filter types is based on determination 

of the filter pass band, and the attenuation in the reject band. The attenuation 

in the reject band that is required by a filter largely determines the slope 

needed in the transmission frequency response. The slope of the filter’s  

response is related to the order of the filter. The steeper the slope or ‘skirt’ of 

the filter; the higher is the order. The term order comes from the mathematical 

transfer function that describes a particular filter. The highest power of s in the 

denominator of the filter’s Laplace transfer function is the order of the filter. 

For the simple low pass and high pass filters presented in this chapter the filter 

order is the same as the number of elements in the filter. However this is not 

the case for general filter networks. In more complex types of lowpass and 

highpass filters as well as bandpass and bandstop filters the filter order will 

not be equal to the number of elements in the filter. In the general case the 

filter order is the total of the number of transmission zeros at frequencies: 

 

 F = 0 (DC)  

 F =   

 0 < F <   (specific frequencies between DC and  ) 

 

Transmission zeros block the transfer of energy from the source to the load. In 

fact the order of a filter network can be solved visually by adding up the 

number of transmission zeros that satisfy the above criteria. Figure 4-25 

shows the relationship between the filter order and slope of the response for a 

Low Pass filter. Each filter of Figure 4-26 has the same cutoff frequency of 

1000 MHz. The third order filter has an attenuation of about 16 dB at a 

rejection frequency of 2000 MHz. The fifth order filter shows an attenuation 

of 39 dB and the seventh order filter has more than 61 dB attenuation at 2000 

MHz. It is therefore clear that the order of the filter is one of the first criteria 

to be determined in the filter design. It is dependent on the cutoff frequency of 

the pass band and the amount of attenuation desired at the rejection frequency. 
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Figure 4-25A Relationship between filter order and the slope of S21 

 

 
 

Figure 4-25B Relationship between filter order and the slope of S21 

 

4.7.3 Filter Type 

 

The shape of the filter passband and attenuation skirt can take on different 

shape relationships based on the coupling among the various reactive elements 

in the filter. Over the years several polynomial expressions have been 

developed for these shape relationships. Named after their inventors, some of 

the more popular types include: Bessel, Butterworth, Chebyshev, and Cauer. 

Figure 4-26 shows the general shape relationship among these filter types. The 

Bessel filter is a low Q filter and does not exhibit a steep roll off. The benefit 

of the Bessel filter is its linear phase or flat group delay response. This means 

that the Bessel filter can pass wideband signals while introducing little 

distortion. The Butterworth is a medium Q filter that has the flattest pass band 

of the group. The Chebyshev response is a higher Q filter and has a noticeably 

steeper skirt moving toward the reject band. 
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Figure 4-26 A shape of Bessel and Butterworth filters 

 

 
 

Figure 4-26 B shape of Chebyshev, and Cauer filters 

 

As a result it exhibits more transmission ripple in the pass band. The Cauer 

filter has the steepest slope of all of the four filter types. The Cauer filter is 

also known as an elliptic filter. Odd order Chebyshev and Cauer filters can be 

designed to have an equal source and load impedance. The even order 

Chebyshev and Cauer filters will have different output impedance from the 

specified input impedance. Another interesting characteristic of the Cauer 

filter is that it has the same ripple in the rejection band as it has in the pass 

band. The Butterworth, Chebyshev and Cauer filters differ from the Bessel 

filter in their phase response. The phase response is very nonlinear across the 

pass band. This nonlinearity of the phase creates a varying group delay. The 

group delay introduces varying time delays to wideband signals which, in 

turn, can cause distortion to the signal. Group delay is simply the derivative, 

or slope, of the transmission phase and defined by Equation (4-34). Figure 4-

27 shows the respective set of filter transmission characteristics with their  
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corresponding group delay. Note the relative values of the group delay on the 

right hand axis.  

 






d

d
g       (4-34) 

 

where,   is phase shift in radians and  is frequency in radians per second. 

From the group delay plots of Figures 4-27 it is evident that the group delay 

peaks near the corner frequency of the filter response. The sharper cutoff 

characteristic results in greater group delay at the band edge. 

 

4.7.4 Filter Return Loss and Passband Ripple 

 

The Bessel and Butterworth filters have a smooth transition between their 

cutoff frequency and rejection frequency. The forward transmission, S21, is 

very flat vs. frequency. The Chebyshev and Cauer filters have a more abrupt 

transition between their cutoff and rejection frequencies. This makes these 

filter types very popular for many filter applications encountered in RF and 

microwave engineering. It is also clear from Figure 4-27 that a sharp-cutoff 

response is generally incompatible with a good phase response or group delay 

in the passband region [6]. 
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Figure 4-27 Group delay characteristic for various lowpass filter types 

 

The Chebyshev and Cauer filter types have ripple in the forward transmission 

path, S21. The amount of ripple is caused by the degree of mismatch between  

the source and load impedance and thus the resulting return loss that is 

realized by these filter types. For a given Chebyshev or Cauer filter order, the  

roll off of the filter response is also steeper for greater values of passband 

ripple. The cutoff frequency of the filters that have passband ripple is then 

defined as the passband ripple value. For all-pole filters such as the 

Butterworth, the cutoff frequency is typically defined as the 3 dB rejection 

point. Figure 4-28 shows the passband ripple of a fifth order low pass filter for 

ripple values of 0.01, 0.1, 0.25, and 0.5 dB. Note that the ripple shown is 

produced by ideal circuit elements. In practice the finite unloaded Q or losses 

in the inductors and capacitors will tend to smooth out this ripple.  
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Figure 4-28 Passband ripple values in lowpass Chebyshev filter 

 

In Chapter 2 the relationship for mismatch loss between a source and load was 

presented. For the Chebyshev and Cauer filters this mismatch loss is the 

passband ripple.  

 

 
 

Figure 4-29 Calculation of filter ripple versus VSWR 

 

Figure 4-30 shows the same filters from Figure 4-28 with the return loss 

plotted along with the insertion loss, S21. We can see that for a given filter  
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order, there is a tradeoff between filter rejection and the amount of ripple, or 

return loss, that can be tolerated in the passband. In most RF and microwave 

filter designs the 0.01 and 0.1 dB ripple values tend to be more popular. This 

is due to the tradeoff between good impedance match and reasonable filter 

skirt slope. Figure 4-28 shows good correlation of the worst case return loss 

with that which is calculated in Figure 4-29. When tuning filters using modern 

network analyzers it is sometimes easier to see the larger changes in the return 

loss as opposed to the fine grain ripple as shown in Figure 4-28. For this 

reason it is common to tune the forward transmission of the filter by observing 

the level and response of the filter’s return loss. Return loss is a very sensitive 

indicator of the filter’s alignment and performance. 

 

 
Figure 4-30A Lowpass Chebyshev filter rejection and return loss versus 

passband ripple 

 

 
 

Figure 4-30B Lowpass Chebyshev filter rejection and return loss versus 

passband ripple 

 

4.8 Lumped Element Filter Design 
 

Classical filter design is based on extracting a prototype frequency-normalized 

model from a myriad of tables for every filter type and order. 
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Fortunately these tables have been built into many filter synthesis software 

applications that are readily available. In this book we will examine the filter 

synthesis tool that is built into the ADS software. We will work through two 

practical filter examples, one low pass and one high pass using the ADS filter 

synthesis tool. 

 

4.8.1 Low Pass Filter Design Example 
 

As a practical filter design, consider a full duplex communication link 

(simultaneous reception and transmission) through a satellite with the 

following requirements:  

 

 The uplink signal is around 145 MHz while the downlink is at 435 MHz.  

 A 20 W power amplifier is used on the uplink with 25 dB gain. 

 It is necessary to provide a low pass filter on the uplink (only pass the 145 

MHz uplink signal while rejecting any noise power in the 435 MHz band. 

 It is necessary to provide a high pass filter on the downlink so that the 435 

MHz downlink signal is received while rejecting any noise at 145 MHz. 

 

The transmitter and receiver antennas are on the same physical support boom 

so there is limited isolation between the transmitter and receiver. Even though 

the signals are at different frequencies, the broadband noise amplified by the 

power amplifier at 435 MHz will be received by the UHF antenna and sent to 

the sensitive receiver. Because the receiver is trying to detect very low signal 

levels, the received noise from the amplifier will interfere or ‘de-sense’ the 

received signals.  

 

Example 4.8-1: Design a 145 MHz Low Pass filter for this satellite link 

system with the following specifications.  

 

 Having a Chebyshev Response with 0.1 dB pass band ripple.  

 Having a passband cutoff frequency (not the -3 dB frequency) at 160 MHz 

 Having at least -40 dB rejections at 435 MHz.  

 

Solution: Create a new workspace, EX4.8-1_wrk, and a new schematic in 

cell_1. Follow the procedure below to design the low pass filter. 
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 From the schematic window, click DesignGuide > Filter > Filter 

Control Window to open the Filter DesignGuide Control Window, as 

shown in Figure 4-31.  

 

 
 

Figure 4-31 Filter DesignGuide control window 

 

 In the Filter DesignGuide Control Window, click View > Component 

Palette-All to place the SmartComponent Palettes in the schematic 

window. 

 

 From the list of Filter DG - All Palette in the schematic window, 

select the lowpass filter SmartComponenet, DA_LCLowpassDT. 

  

 
 

Figure 4-32 SmartComponent Palette in the schematic window 
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 Click anywhere within the schematic window to place the component. 

 

 Double-click the SmartComponent to open a dialog box containing all 

parameters. 

 

 Modify the parameters to meet the design specifications, as shown in 

Figure 4-33. 

 

 
 

Figure 4-33 Modified parameters of the lowpass filter 

 

 In the Filter DesignGuide control window select the Filter Assistant 

tab and click Design to start a simulation and generate the filter sub-

network, as shown in Figure 4-34. 
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Figure 4-34 Lowpass filter sub-network (N=5) 

 

The required filter order is determined by increasing the order until the 

specification of -40 dBc attenuation at 435 MHz is achieved. As the filter 

response curve in Fig.4-36 shows, this Low Pass filter must be of fifth order to 

achieve the required attenuation.  

After SmartComponents are designed and tested, they can be used as 

standalone components. The Filter DesignGuide is not needed to use them in 

new designs unless you want to modify or analyze them. In Figure 4-35 the 

lowpass filter SmartComponent is used in S parameter simulation circuit. 

 

 
 

Figure 4-35 SmartComponent used in S parameter simulation circuit 
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Simulated Response of the low pass filter is shown in Figure 4-36. 

 

 
 

Figure 4-36 Simulated Response of the low pass filter  

 

4.8.2 Physical Model of the Low Pass Filter in ADS 

 

It is important to realize that the synthesized filter is an ideal design in the 

sense that ideal (no parasitics and near infinite Q) components have been 

used. To obtain a good ‘real-world’ simulation of the filter we need to use 

component models that have finite Q and parasitics such as multilayer chip 

capacitors for shunt capacitors. For the capacitors, choose the 6003 series chip 

capacitors from ATC Corporation. ATC Corporation has a useful application 

for selection of chip capacitors called ATC Tech Select. This program is 

available for free download from the ATC web site: www.atceramics.com. 

ATC also provides S-Parameter files for their capacitors that are readily 

available on the company website. For the physical design of the filter in 

Figure 4-37 the ATC capacitor models must be installed into the ADS 

workspace.  

 

Because the filter is passing relatively high power (20 W), we cannot use 

small surface mount style chip inductors. Instead we will use air wound coils 

to realize the series inductors. The inductors will be realized with AWG#16 

wire nickel-tin plated copper wire. The wire has a diameter of 0.05 inches or 

50 mils. They will be wound on a 0.141 inch diameter form. Use the 

 

 

http://www.atceramics.com/
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techniques covered in Chapter one, Section 1.4.1 to design the air-core  

wound inductors. The filter model is then reconstructed using the physical 

inductor models for the series inductors. Make sure to model the substrate and 

the interconnecting printed circuit board traces as microstrip lines. Also model 

the ground connection of the shunt capacitors as a microstrip via hole.  

 

Although these PCB parasitic effects are normally more pronounced at 

frequencies above 2 GHz, it is often surprising the effect that these parasitics 

have at lower frequencies. The physical filter schematic is shown in Figure 4-

37.  

 

 
 

Figure 4-37 Schematic of the physical low pass filter 

 

The physical filter response is shown in Figure 4-38. 

 

 
 

Figure 4-38 Response of the physical lowpass filter 

 



46 RF and Microwave Circuit Design 

 

 

The response shows that the attenuation specification at 435 MHz has been 

achieved. Because the circuit has physical models replacing the ideal lumped 

elements, the engineer is reasonably confident that the filter can be assembled 

and will achieve the designed response. I section 4.9 the lumped element 

filters are transformed to microstrip line filters with layouts for EM 

simulation.  

 

Figure 4-39 is a photo of the prototype low pass filter circuit with SMA 

coaxial connectors attached to the circuit board. 

 

 
 

Figure 4-39 Physical prototype of the low pass filter (courtesy of BT 

Microwave LLC) 

 

4.8.3 High Pass Filter Design Example 
 

Example 4.8-2: Design a high pass filter that passes frequencies in the 420 

MHz to 450 MHz range. This filter could be placed in front of the preamp 

used in the downlink of the satellite system. This would help to keep out any 

of the transmit energy or noise power in the 146 MHz transmit frequency 

range. The High Pass Filter specifications are: 

 

 The pass band cutoff frequency (not the -3 dB frequency) is 420 MHz. 

 The filter has a Chebyshev response with 0.1 dB pass band ripple.  

 The reject requirement is at least -60 dB rejections at 146 MHz.  

 

Solution: Following the procedure in Example 4.8.1 create a new workspace 

in ADS and open a new schematic window. From the schematic window, 

click DesignGuide > Filter > Filter Control Window to open the Filter 

DesignGuide control window. In the Filter DesignGuide control window, 

click View > Component Palette-All to place the filter SmartComponent 
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Palette in the schematic window. From the list of Filter DG-All Palette 

select the highpass filter SmartComponenet, DA_LCHighpassDT, and click 

anywhere within the schematic window to place the component. Modify the 

component parameters to meet the highpass filter design specifications, as 

shown in Figure 4-40. 

 
 

Figure 4-40 Parameters of the highpass filter  

 

The required filter order is determined by increasing N until the specification 

of -60 dBc attenuation at 146 MHz is achieved. It is always a good practice to 

design for some additional rejection (margin) that exceeds the minimum 

requirement, as shown in Figure 4-41. The Filter DesignGuide session 

recommends a filter of 7th order.  

 

 
 

Figure 4-41 DesignGuide highpass filter response 
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The high pass filter sub-network is shown in Figure 4-42. 

 

 
 

Figure 4-42 Lumped element model of the high pass filter (N=7) 

 

Attach 50 Ohm terminations to the highpass filter SmartComponent model 

and simulate the schematic from 100 to 500 MHz, as shown in Figure 4-43. 

 

 
 

Figure 4-43 Simulation of the high pass filter 

 

The simulated response of the highpass filter is shown in Figure 4-44. 

 

 
Figure 4-44 Response of the high pass filter 
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As Figure 4-44 shows the attenuation of -60 dBc at 146 MHz has been 

achieved with a good margin. 

 

4.8.4 Physical Model of the High Pass Filter in ADS 

 

Using the same techniques as described for the Low Pass Filter design we can 

proceed with the High Pass Filter realization. The Filter DesignGuide 

application calculated series capacitance values of 6.416 pF and 3.614 pF. 

Looking through the available ATC 700B series chip capacitors, the nearest 

values are 6.8 pF and 3.9 pF capacitors. The shunt inductors are realized using 

the Air Wound inductor models. Figure 4-45 shows the completed assembly 

of the High Pass Filter on a printed circuit board with coaxial SMA 

connectors. 

 

 

 

 

 

 

 

 

 

 

Figure 4-45 Physical prototype of the 420 MHz highpass filter (courtesy of BT 

Microwave LLC) 

 

4.9 Distributed Filter Design  

 

4.9.1 Microstrip Stepped Impedance Low Pass Filter 

Design  

 

In the microwave frequency region filters can be designed using distributed 

transmission lines. Series inductors and shunt capacitors can be realized with 

microstrip transmission lines. In the next section we will explore the 

conversion of a lumped element low pass filter to a design that is realized 

entirely in microstrip.  
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Example 4.9-1: Design a lumped element 2.2 GHz Chebyshev-response 

lowpass filter having 0.1 dB passband ripple and -40 dB rejection at 6 GHz. 

Convert all the lumped elements to microstrip transmission lines. The 

microstrip substrate is Rogers’s 6010 material (εr= 10.2) with a 0.025 inch 

dielectric thickness. 

 

Solution: Following the procedure discussed in Example 4.8-1, the 

SmartComponent design of the lowpass filter is show in Figure 4-46.  

 

 
 

Figure 4-46 Lumped element design of the 2.2 GHz low pass filter  

 

The lumped element sub-network of the filter is shown in Figure 4-47. 

. 

 
 

Figure 4-47 Lumped element 2.2 GHz low pass filter 

 

The simulated response of the filter is shown in Figure 4-48. 

 

 

 

 



Resonant Circuits and Filters 51 

 

 

 
 

Figure 4-48 Response of the lumped element 2.2 GHz lowpass filter  

 

The marker m1 in Figure 4-48 shows that the 3 dB bandwidth of the lowpass 

filter is 2495 MHz. 

 

4.9.2 Lumped Element to Distributed Element 

Conversion 

After a Filter DesignGuide SmartComponent has been designed, the lumped 

inductors and capacitors can be transformed into equivalent distributed 

element counterparts using the ADS Transformation Assistant. The Filter 

Transformation Assistant helps us to quickly and easily transform an ideal 

filter topology to a form that is realizable for RF and microwave systems. 

The Transformation Assistant is opened from the Filter DesignGuide Control 

window, by selecting Tools > Distributed Element Transformations. When the 

Transformation Assistant is opened, the SmartComponent subnetwork appears 

in the schematic window and a dialog box is opened. The transformations are 

then accomplished using the controls on the dialog box. 

After the Transformation Assistant has been selected, the graphical area 

displays the components that can be transformed. Black components represent 

elements included in the original circuit available for transformation, while 

gray components represent elements not included in the original circuit.  

Check the LC, TLine to Microstrip transformations and select the series 

inductors L1 and L2 to be transformed to microstrip transmission lines. 
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Set the characteristic impedance of the microstrip line to Z0 = 80 Ohm and 

enter the microstrip substrate parameters, as shown in Figure 4-49. 

 

 

 

Figure 4-49 Transformation Assistance window 

 

Click Transform and then click OK. As Figure 4-50 shows the series inductors 

L1 and L2 have been transformed to 80 Ω microstrip transmission lines on the 

microstrip substrate. 

 

 

 

Figure 4-50 Series inductors transformed to microstrip lines 
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From the graphical area, use the left red arrow to select the shunt capacitors 

for transformation. The graphical area changes to reveal the other distributed 

element equivalents available for substitution. Repeat the same process for the 

capacitors but select Z0 = 20 Ohm, as shown in Figure 4-51. 

 

 

 

Figure 4-51 Transformation of shunt capacitors to 20 Ω microstrip line 

 

Click Transform and then click OK. Now the capacitors have also been 

transformed to microstrip lines.  

 

 

 

Figure 4-52 Initial schematic of the distributed low pass filter 
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Now the lumped element filter in Figure 4-47 has been converted to 

microstrip stepped impedance low pass filter of Figure 4-52. Simulate the 

schematic in Figure 4-46 and display the response from 0 to 10 GHz. 

  

 

Figure 4-53 Initial response of the low pass filter 

 

Note that the marker m1 in Figure 4-53 shows that the 3 dB bandwidth of the 

lowpass filter has slightly decreased to 2421 MHz. 

 

The printed circuit board layout of the initial lowpass filter is shown in Figure 

4-54. 

 
Figure 4-54 Initial PCB layout of the lowpass filter 

 

Examine the printed circuit board, PCB, layout of the lowpass filter of Figure 

4-54. Note the change in geometry as the impedance transitions from 50  at 

the input to 20  representing the shunt capacitor, and then from 20  to 80 

 representing the series inductor. These abrupt changes in geometry are 

known as discontinuities. Discontinuities in geometry result in fringing 

capacitance and parasitic inductance that will modify the frequency response 

of the circuit. At RF and lower microwave frequencies (up to about 2 GHz)  
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the effects of discontinuities are minimal and sometimes neglected [4]. As the 

operation frequency increases, the effects of discontinuities can significantly 

alter the performance of a microstrip circuit. ADS software has several model 

elements that can help to account for the effects of discontinuities. These 

include: T-junctions, cross junctions, open circuit end effects, coupling gaps, 

and bends.  
 

A Microstrip Step element can be placed between series lines of abruptly 

changing geometry to account for the step discontinuity. Place the Microstrip 

Step element at each impedance transition in the filter. Make sure that the 

narrow side and wide side are directed appropriately. The Microstrip Step 

element, MSTEP, will automatically use the adjacent width in its calculation. 

Figure 4-55 shows the lowpass stepped impedance filter with the step 

elements added between each transmission line section. 

 

 
 
 

Figure 4-55 Stepped impedance filter with added “step” elements 

 

The simulated response of the modified filter is shown in Figure 4-56. 

 

 
 

Figure 4-56 Filter frequency shift due to step discontinuities 
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A comparison of the initial lowpass filter model response in Figure 4-53 and the 

modified model response in Figure 4-56 shows that there is some frequency shift 

in the filter response as it is evidenced, about 100 MHz, by the 3 dB bandwidth. 

 

4.9.3 Electromagnetic Analysis of the Stepped Impedance 
Filter 

 

Electromagnetic, EM, modeling is a useful tool in microstrip circuit design as it 

offers a means of potentially more accurate simulation than linear modeling. The 

linear microstrip component models used to model the stepped impedance filter 

are based on closed form expressions developed over many years. For many 

designs the linear model is quite acceptable. Microstrip circuits that contain 

several distributed components in a dense printed circuit layout will be affected 

by cross coupling and enclosure effects. This is because the microstrip circuitry is 

quasi-TEM with some portion of the EM fields in the free-space above the 

dielectric material. These effects are very difficult to accurately simulate with 

linear modeling techniques. The ADS software suite has a very useful 

electromagnetic (EM) simulation engine named Momentum. Momentum is based 

on the method-of-moments (MoM) numerical solution of Maxwell’s equations [3]. 

Unlike some EM simulation software Momentum’s solutions are presented in the 

S parameter format that is familiar to the microwave circuit designer. A dataset is 

created that can be graphed just like any linear simulation. The Momentum model 

is created from the circuit layout rather than the schematic. In this section we will 

create a Momentum model from the layout that was created by the linear 

schematic. However we could import an arbitrary PCB artwork from any CAD 

program. Right click on the Layout window to expose the Layout Properties. On 

the General Tab make sure to specify the correct units (mils) that represent the 

drawing. Also check the ‘show EM Box’ check box so that a proper enclosure is 

modeled for the circuit. The box represents a metal enclosure that will serve as the 

boundary conditions for the EM simulation. The simulator will identify any box 

resonances that may occur which could have an adverse effect on the circuit 

design. The box sides must be lined up perpendicular to the input and output 

ports. The box size (length and width) can be adjusted by entering the desired 

dimensions in the Box Width (X) and Box Height (Y) settings as shown in Figure 

4-50. The box height is specified in the Layers tab as the air above the metal 

conductor or 250 mils. On the Layer Tab make sure that the microstrip dielectric 

material is defined on the Substrate line. Once all of the Layer settings have been 

specified add the Momentum Analysis to the Workspace as shown in Figure 4-52. 
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Figure 4-57 General and layer tabs of the layout properties 
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Figure 4-58 Filter layout showing box outline and conductor mesh 
 
 

 
 
 

Figure 4-59 Momentum simulation options setup 
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On the General Tab, set the start and stop frequency for the simulation and select 

the adaptive sweep type. The adaptive sweep reduces frequency point 

interpolation error. On the Simulation Options Tab choose the RF simulation 

mode. The RF simulation mode is a much faster EM simulation and is suitable for 

lower microwave (RF) frequencies where there is not a significant amount of 

coupling among transmission lines. The Microwave simulation mode is a full 

wave EM analysis that includes all coupling radiation within the box. Also check 

the ‘Calculate – All’ button so that the metal mesh and the substrate are used in 

the solution. 

 

 
 

Figure 4-60 Linear simulation and momentum simulation comparison 

 

The comparison between the Linear and Momentum simulations shows that there 

is some further deviation in the filter rejection as the frequency increases above 2 

GHz. 
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Figure 4-61 3D View of filter and prototype filter printed circuit board 

 

4.9.4 Microstrip Edge Coupled Line Filter Design 
 

The edge coupled microstrip line is very popular in the design of bandpass 

filters. A cascade of half-wave resonators in which quarter wave sections are 

parallel edge coupled lines, are very useful for realizing narrow band, band 

pass filters. This type of filter can typically achieve < 15% fractional 

bandwidths [4].  

 

Example 4.9-2: Design a band pass filter at 10.5 GHz. The filter is designed 

on RO3010 substrate (r = 10.2) with a dielectric thickness of 0.025 inches. 

The filter should have a pass band of 9.98 – 11.03 GHz. As a design goal the 

filter should achieve at least 20 dB rejection at 9.65 GHz. In other words the 

filter is required to have > 20 dB rejection at 330 MHz below the lower 

passband frequency.  

 

Solution: The Passive Circuit DesignGuide utility in ADS is used to design 

the filter network. The procedure for opening and using the Passive Circuit 

DesignGuide utility is as follows. 

 

1. In the schematic window, choose DesignGuide > Passive Circuit > Passive 

Control Window. 

2. From Passive Circuit DesignGuide toolbar, choose View > Component 

Pallet > Microstrip. 

3. From Passive Circuit DG – Microstrip pull-down list, choose Filter-

Bandpass 

4. From Filter-Bandpass pull-down list, choose Chebyshev  
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5. Set the filter parameters and vary the order until the desired filter rejection 

is achieved.  

 

The Passive Circuit DesignGuide program shows that a 6th order filter should 

meet the rejection specifications. The synthesized filter schematic and 

response are shown in Figures 4-61 and 4-62. 

 

 
 

Figure 4-61 Parallel line edge coupled microstrip bandpass filter schematic 

 

 

 
 

Figure 4-62 Band pass filter response 

 
4.9.5 Electromagnetic Analysis of the Edge Coupled Filter 
 
The designer must be cautious when using Linear Analysis techniques to design 

circuits with multiple edge coupled microstrip lines. We know that there is a large 

percentage of the parallel line coupling that occurs in the free space above the 

microstrip substrate and the conductors. This can lead to considerable error when 

relying on the linear simulation results. The coupled line models used by the 
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linear simulator are based on closed form expressions derived from coupling 

measurements on parallel lines with loosely defined boundary conditions.  

 

Example 4.9-3: Use the microwave mode in the Momentum software to simulate 

the edge coupled filter.  

 

Solution: Using the circuit model created in the last section examine the layout of 

the filter. On the Layout-Properties window, make sure that the “Show EM Box” 

is selected. Then adjust the size of the box to fit the filter. Set the filter box width 

(Y) to 400 mils and the box height (X dimension) to 760 mils. The EM box will 

show up as a red rectangle on the layout window. Next edit the Layer tab. Check 

the “Show All” box. Scroll across to make sure that the substrate thickness, 

dielectric constant, and loss tangent parameters are correct. Check “Use” boxes as 

appropriate. Set the initial box height (Z dimension) at 300 mils. 

 

 
 

Figure 4-63 Layer setup for momentum analysis of edge coupled filter 



Resonant Circuits and Filters 63 

 
 

Add a Momentum GX Analysis to the workspace and set the parameters as shown 

in Figure 4-64. Set the analysis frequency range of 9 to 12 GHz with an Adaptive 

sweep type. On the Simulation Options tab, make sure that the “use box” check 

box has been selected. This forces a 3D mesh of the entire filter and box. This 

time we must select the microwave simulation mode so that the box radiation 

effects are properly modeled. 

 

 
 

Figure 4-64 Momentum GX general setup 
 

Perform a Momentum simulation on the filter and observe the response. The 

edge-coupled filter is particularly sensitive to the sidewalls providing the proper 

boundary conditions for the coupled energy between the parallel-coupled lines. 

Begin the tuning process by first reducing the box height to 250 mils. Keep the 

cover height at 250 mils. A 3D picture of the filter is shown in Figure 4-66 to 

have a good appreciation of the physical geometry of the filter. Figure 4-65 shows 

the comparison between the linear model and the Momentum EM model. We see 

that the actual pass band is shifted up in frequency slightly while the bandwidth 
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has been reduced. Varying the box dimensions shows that the filter skirts are 

heavily dependent on the box around the filter. 

 

 
 

Figure 4-65 Comparison between the linear and the Momentum EM model 

 
 

 
 

Figure 4-66 3D View of the edge coupled filter showing layer stack 
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Problems 

 

4-1. Consider the one port resonator that is represented as a series RLC circuit 

as shown. Analyze the circuit, with R = 5 , L = 5 nH, and  C = 5 pF. Plot 

the magnitude of the resonator input impedance and measure the 

resonance frequency. 

 

4-2. Consider the one port resonator that is represented as a parallel RLC 

circuit as shown. Analyze the circuit, with R = 500 , L = 50 nH, and C = 

50 pF. Plot the magnitude of the resonator input impedance and measure 

the resonance frequency. 

 

4-3. Design a Butterworth lowpass filter having a passband of 2 GHz with an 

attenuation 20 dB at 4 GHz. Plot the insertion loss versus frequency from 

0 to 5 GHz. The system impedance is 50 . 

 

4-4. Design a 5th order Chebyshev highpass filter having 0.2 dB equal ripples 

in the passband and cutoff frequency of 2 GHz. The system impedance is 

75 . Plot the insertion loss versus frequency from 0 to 5 GHz. 

 

4-5. In a full duplex communication link, the uplink signal is around 200 MHz 

while the downlink is at 500 MHz. A 25 Watt power amplifier is used on 

the uplink with 20 dB gain. 

 

(a) Design a low pass filter on the uplink to pass the 200 MHz uplink 

signal while rejecting any noise power in the 500 MHz band. Design 

the passband cutoff frequency is at 220 MHz, therefore, the filter 

should have a Chebyshev Response with 0.1 dB pass band ripple. The 

reject requirement is at least -40 dB rejections at 500 MHz. 

 

(b) Design a High Pass Filter that passes frequencies in the 480 MHz to 

520 MHz range. The High Pass Filter specifications are: The passband 

cutoff frequency is 480 MHz, therefore, the filter should have a 

Chebyshev response with 0.1 dB pass band ripple. The reject 

requirement is at least -60 dB losses at 190 MHz.  
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4-6. Design a 75  transmission line of sufficient length to act as a 10 nH 

inductor. Calculate the microstrip line width on the Rogers 0.025 inch 

RO3010 material. 

 

4-7. Using the microwave filter synthesis tool, design a stepped impedance low 

pass filter on RO3003 material that is 0.010 inches thick. Use a Chebyshev 

response with a 0.01dB ripple and a cutoff frequency of 4 GHz. Determine 

the worst case in band return loss and the rejection at 6 GHz. 

 

4-8. For the filter design of Problem 4-7 create an EM simulation using 

Momentum. Compare the EM simulation to a linear simulation. Comment 

on the rejection comparison at 6 GHz. 

 

4-9. For the filter design of Problem 4-7 determine the frequencies at which 

reentrant modes exist up through 20 GHz. 

 

4-10. Design a half wave microstrip resonator at 10 GHz using RO3003 

substrate that is 0.020 thick. Initially design the resonator with a 50 W line 

impedance. Select a coupling capacitor to critically couple the resonator to 

the 50  source. Then determine the resonator line impedance that results 

in the highest unloaded Qo. 

 

4-11. Use the microwave filter synthesis tool to design a parallel edge coupled 

filter on RO3003 substrate that is 0.010 thick. Use a Chebyshev 

characteristic with 0.10 dB ripple. Design the passband to cover 10.7 GHz 

to 12.2 GHz. Determine the filter order required to achieve 30 dB rejection 

at 9 GHz. 

 

4-12. For the filter design of Problem 4-10, create an EM simulation using 

Momentum. Compare the linear and EM simulations. Determine the 

minimum box width (EM Box height, Y) that creates a box resonance 

frequency. What is the frequency of the box resonance? 
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